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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

LOGO! –

تجزییا....کلید زنی و کنترلی ابتکاری 

The Original!

مقدمه
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

در جزییات آن در یک نگاه! لوگو

نصب و سیم بندی
 مونتاژ و نصب دستگاه
 نصب و جدا کردن دستگاه در محل
 اتصال به برق
 اتصال ورودی ها و خروجی ها
 روشن شدنرفتار 
توابع
 توابع پایه
 توابع خاص
عملیات روی خود دستگاه
 کنترل عملیات
 اولین برنامه
 در حالت اجرا برنامه! لوگو
 !تنظیمات لوگو
LOGO! Soft Comfort 5.0
 نصب برنامه
 توابع راهنما
 درک قدم به قدم فرامین معمولی
 دیگر گزینه ها

-مثال کاربردی  PowerEn.ir
 کنترل یک دستگاه شیشه پرکن 

مقدمه
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نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

نصب و سیم بندی

N

K2 

L1

K2 

I : 

0..  123456789

1..0123456789

2..01234

4

نصب و سیم بندی
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

!ساختار سخت افزاری لوگو

دیجیتالورودی 24 :آرایش حداکثر آنالوگورودی  8 +
خروجی دیجیتال 16 + خروجی آنالوگ 2 +

اتصال برق

محل اتصال تغذیه برای واحد های توسعه

توقف/ اجرا 

خروجی 4

ورودی  4 

ورودی 8

کلید برای اتصال 
برق

4خروجی

صفحه 
نمایش
تضاد رنگ 
قابل کنترل

The internal
qualities

count

نصب و سیم بندی
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نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

نصب
:روی ریل! برای سوار کردن لوگو

را در ریل قرار دهید! لوگو
را تا حدی روی ریل بلغزانید تا کاملا پشت لوگو در ریل قرار گیرد! لوگو

ساده و مدول توسعه کاور اتصال را بردارید! در سمت راست لوگو
پایه را در بالا قرار دهید! مدول دیجیتال لوگو

مدول دیجیتال را به سمت چپ بلغزانید
از یک پیچ گوشتی استفاده نموده و مدول را در سمت چپ در محل نهایی اش قرار دهید

1

2

3

4

5

6

!نصب و جدا سازی لوگو

نصب و سیم بندی
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

!نصب و جدا سازی لوگو
جدا سازی

! :برای جدا کردن لوگو
با استفاده از یک پیچ گوشتی لغزنده را به پایین و راست منتقل کنید

مدول توسعه را بعه راست بلغزانید و
یک پیچ گوشتی را در سوراخی که در پایین انتهای محل نصب وجود دارد فرو برده و آنرا به راست فشار 

دهید
مدول توسعه را به راست بلغزانید

قدمهای بالا را برای مدول پایه تکرار کنید 

1

2

1

2

3

4

A B

نصب و سیم بندی
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

:به برق! اتصال لوگو

ML+ I1 I2 I3 I4 I5

L1L+

NM

I1 I2 I3 I4L1 N

:(توصیه می شود) حفاظت با فیوز 
12/24 RC...: 0.8 A
24: 2.0 A

برای حفاظت در برابر تغییرات شدید و 
درصد بالا 20ناگهانی از یک وریستور با ولت 

تر ولت نامی

:با برق مستقیم!لوگو:با برق متناوب!لوگو

!لوگوسیم بندی

نصب و سیم بندی



و راه اندازیاتوماسیون

!لوگو

Logic Module LOGO! 
A&D AS, 02/2006, Chart 9

© Siemens AG 2006  - Subject to change without notice

مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

! لوگواتصال ورودی ها به
!.اتصال سنسورها به لوگو

:سنسورهای کاربردی شامل
 ... .شاسی ها وکلیدها ویا سویچ های فتو الکتریک و
 ولت10تا 0سنسورهای دما وفشار و غیره با خروجی 
 2میلی آمپر به ورودی های آنالوگ ماژول ای ام 20تا0یا دستگاه هایی مناسب با جریان خروجی 
 یا اتصال به دو یا بیشتر ترمومتر مقاومتی با دو یا سه سیم 

دستکاه های ورودی باید زمین مشترکی 
داشته باشند

LOGO! 12/24 ...
L+

ML+ I1 I2 I3 I4 I5 I8

M

ورودی ها در دو گروه دسته بندی شده 
تای آنها در یک گروه جا گرفته 4اند و

اند

LOGO! 230 ...

L1

N

NL1 I1 I2 I3 I4 I5 I6

L3
L2

با اتصال دوسیمه امکان تصحیح در اندازه 
گیری  وجود ندارد ولی در اتصال سه سیمه 

ممکن است

2-wire technology 3-wire technology

نصب و سیم بندی
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

!لوگواتصال خروجی ها به

شما می توانید خروجی 
:های متفاوتی شامل 
 چراغها
 موتورها
 سویچ ها
 غیره

با خروجی ! لوگو
ترانزسیتوری

با خروجی رله ! لوگو
ای

آمپر0.3ماکزیمم جریان برای خروجی 

آمپر10ماکزیمم جریان برای خروجی 
آمپر5و برای مدول توسعه 

DM8 24

Q5 M Q6 M

load load

Q1 M Q2 M

Q2Q1
1 21 2

Q5
1 2

Q6
1 2

DM8...R

loadload
N M

1

نصب و سیم بندی
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

!لوگواتصال خروجی ها به

با خروجی ! لوگو
آنالوگ

شما می توانید دستگاههای 
متفاوتی شامل موارد زیر را به 

:خروجی وصل کنید
 مبدل فرکانس برای کنترل
راه اندازها
 دیگر ورودیها با امپدانس 
بالا

!اخطار
خروجی ها نباید 

بار شوند 
ماکزیمم جریان 

0.2خروجی 
آمپر است

اتصال زمین
مقطع عرضي
ریل

نصب و سیم بندی
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

:وقتی روشن می شود وابسته است به! عکس العمل لوگو

 آیا برنامه ای در حافظه داخلی موجود هست؟
یا
 آیا کارت حافظه متصل شده است؟

هیچ برنامه ای در کارت و 
حافظه دستگاه موجود 
نیست

برنامه ای در کارت یا 
دستگاه موجود است

!اخطار
اگر در دستگاه برنامه ای باشد و 

کارت را وارد کنیم به محض روشن 
شدن دستگاه برنامه کارت در 

دستگاه کپی شده و برنامه در درون 
حافظه داخلی دستگاه پاک می 

شود
LOGO!

> Program

Card..

Setup..

Start

s

LOGO!

No Program

Press ESC

sنصب و سیم بندی
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نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

:وقتی روشن می شود وابسته است به! عکس العمل لوگو

حالت قبل از خاموش 
شدن بعد از روشن شدن

در حالت ویرایش 
برنامه ویا در منوها 
در حالت توقف

در حالت اجرا برنامه

 حالت قبل از خاموش شدن دستگاه کدامیک بوده است؟

حالت قبل از خاموش 
شدن بعد از روشن شدن

LOGO!

> Program

Card..

Setup..

Start

s

LOGO!

s

Q1

LOGO!

s

I :

0..  123456789

1..0123456789

2..01234

LOGO!

s

I :

0..  123456789

1..0123456789

2..01234

نصب و سیم بندی
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نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir تابع پایه8

توابع پایه

AND AND 
(edge)

NAND NAND 
(edge)

OR NOR XOR NOT

The 
internal
qualities

count

توابع
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

AND تابع

میشود که همه 1خروجی این تابع زمانی 
باشند1ورودی ها 

اگر یکی از ورودی ها وصل نباشد به صورت 
فرض می شود1خودکار 

:جدول درستی این تابع

با یک نگاه به مدار معادل می توان گفت که وقتی لامپ روشن است که کلید 
حالت ورودی و خروجی وابسته به هم هستند.بسته باشند 3و2و1های 

مدار معادل گیت در روبرو رسم شده است ودر یک کلام می توان گفت که 
.وقتی چراغ روشن است که هر سه کلید بسته باشند

:شمای این گیت در زیر آمده است

یک مدار سری با 
کنتاکت های باز

&S1

S2

x

H1

AND

S3

S2

S3

H1

S1

Input 3 Output

0 0 0 0

0 0 1 0

0 1 0 0

0 1 1 0

1 0 0 0

1 0 1 0

1 1 0 0

1 1 1 1

Input 2Input 1

توابع
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نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

میشود که یکی از 1خروجی این تابع زمانی 
باشد1ورودی ها 

اگر یکی از ورودی ها وصل نباشد به صورت 
فرض می شود0خودکار 

با یک نگاه به مدار معادل می توان گفت که وقتی لامپ روشن است که 
حالت ورودی و خروجی از هم مستقل . بسته باشند3یا2یا 1کلید های 

هستند
ودر یک کلام می توان گفت که وقتی چراغ روشن است که حداقل یکی 

:شمای این گیت در زیر آمده است. از سه کلید بسته باشند

OR تابع

:عجدول درستی این تاب

مدار موازی با کنتاکت 
های باز

>S1

S2

S3
H2

OR

x

S1 S2

H2

S3

Input  3 Output 

0 0 0 0

0 0 1 1

0 1 0 1

0 1 1 1

1 0 0 1

1 0 1 1

1 1 0 1

1 1 1 1

Input  2Input  1

توابع
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نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

ANDبا تریگرلبه 

1میشود که همه ورودی ها 1خروجی این تابع زمانی 
بوده 0باشند و حداقل یکی از ورودی ها در سیکل قبل 

.باشد
فرض 1اگر یکی از ورودی ها وصل نباشد به صورت خودکار 

می شود

ANDبا تریگرلبه 

S1

S2

S3

H2

S1

S2

H2

S3

شمارنده الکترودینامیکی

5160

&S1

S2

x

H2
S3

توابع



و راه اندازیاتوماسیون

!لوگو

Logic Module LOGO! 
A&D AS, 02/2006, Chart 18

© Siemens AG 2006  - Subject to change without notice

مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

با یک نگاه به مدار معادل می توان گفت که وقتی لامپ خاموش است 
.باز باشند3و2و1که کلید های 

.مدار معادل گیت در روبرو رسم شده است
ودر یک کلام می توان گفت که وقتی چراغ خاموش است که همه سه 

.کلید باز باشند
:شمای این گیت در زیر آمده است

NAND (not-AND) تابع

میشود که همه 1خروجی این تابع زمانی 
باشند0ورودی ها 

اگر یکی از ورودی ها وصل نباشد به صورت 
فرض می شود1خودکار 

جدول درستی این 
:تابع

مدار موازی با کنتاکت 
های بسته

S1 S2 S3

H2

&S1

S2

S3
H2

NAND

x

Input  3 Output 

0 0 0 1

0 0 1 1

0 1 0 1

0 1 1 1

1 0 0 1

1 0 1 1

1 1 0 1

1 1 1 0

Input  2Input  1

توابع
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نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

با لبه تریگر NAND

S1

S2

S3

H2

میشود که حداقل یکی از ورودی 1خروجی این تابع زمانی 
بوده 1باشند و حداقل یکی از ورودی ها در سیکل قبل 0ها 

.باشد
فرض 1اگر یکی از ورودی ها وصل نباشد به صورت خودکار 

می شود

شمارنده الکترودینامیکی

NANDبا تریگرلبه

S1 S3 S3

H2

5160

&S1

S2

S3
H2

x

توابع
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نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

با یک نگاه به مدار معادل می توان گفت که وقتی لامپ خاموش است که 
باز باشند3یا2یا 1کلید های 

.مدار معادل گیت در روبرو رسم شده است
ودر یک کلام می توان گفت که وقتی چراغ خاموش است که یکی از سه 

.کلید باز باشند
:شمای این گیت در زیر آمده است

NOR (not-OR) تابع

میشود که همه ورودی 1خروجی این تابع زمانی 
باشند0ها 

اگر یکی از ورودی ها وصل نباشد به صورت 
فرض می شود0خودکار 

یک مدار سری با 
کنتاکت های بسته

:جدول درستی این تابع

NOR

>1S1

S2

S3
H1

x

S1

S2

H1

S3

Input  3 Output 

0 0 0 1

0 0 1 0

0 1 0 0

0 1 1 0

1 0 0 0

1 0 1 0

1 1 0 0

1 1 1 0

Input  2Input  1

توابع
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

XOR تابع

میشود که همه ورودی 1خروجی این تابع زمانی 
ها حالت متفاوت داشته باشند اگر یکی از ورودی 

فرض می شود0ها وصل نباشد به صورت خودکار 

XOR

با یک نگاه به مدار معادل می توان گفت که وقتی لامپ روشن است که 
.سویچ شوند2یا 1تنها یکی از کلید های 

. مدار معادل گیت در روبرو رسم شده است
.سویچ شوند2یا 1وقتی لامپ روشن است که تنها یکی از کلید های 

:شمای این گیت در زیر آمده است

:جدول درستی این تابع
Input  2 Output 

0 0 0

0 1 1

1 0 1

1 1 0

Input  1

=1S1

S2

H1

S1

S2

H1

توابع
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

NOT تابع

باشد این گیت ورودی را 0است که ورودی 1خروجی وقتی 
دیگر نیازی ! معکوس می کند مزیت این گیت آن است که در لوگو

به کنتاکت بسته نیست وشما به راحتی می توانید از یک کنتاکت 
نید بازاستفاده نموده وآن را با یک گیت به کنتاکت بسته تبدیل ک

فرض می 1اگر یکی از ورودی ها وصل نباشد به صورت خودکار 
شود

NOT

1
S1 H1

با یک نگاه به مدار معادل می توان گفت که وقتی لامپ روشن است که 
.کلید بسته نباشد

.مدار معادل گیت در روبرو رسم شده است
شمای این گیت در زیر آمده است

:جدول درستی این تابع
Output 

0 1

1 0

Input  1

S1

H1

K1

توابع
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

توابع خاص – مرور

28
یتابعها

خاص

روشن شدن تاخیری خاموشی تاخیریروشن

شمارنده بالا پایین رو

تولید َکننده تصادفی

یگر آستانه تر

تابع کلید چند گانه

خاموشی تاخیری

رله لچ

رله پاک کننده
تولید کننده پالس

تایمر سالانه

شمارنده ساعت

کلید پلکانی روشن شدن

نگهدارنده تاخیر
روشن شدن

متن پیام

یگر آستانه آنالوگ با تر
مقایسه گر آنالوگ

کلید نرم

لبه تریگر
رله پاک کننده

تایمر هفته ای

شیفت رجیستر

یگر تفاضلی آنالوگ تر

نگهبان آنالوگ

تقویت کننده آنالوگ

رله پالس

تولید کننده پالس

ورودی کنترلر

شیب

ماکس آنالوگ

تایمر

Counter
Miscellaneous

آنالوگ

توابع
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

تاخیری روشن شدنتایمر

توصیف تابع
درواقع .خواهد شد1بوده باشد بعد از مدت تاخیر خروجی 1اگر وضعیت تریگر برای مدتی طولانی 

.شود0خواهد شد هرگاه تریگر 0خروجی ورودی را با یک تاخیر زمانی دنبال میکندخروجی 
شود تایمر ریست می شود0اگر وضعیت ورودی تریگر قبل از اتمام تایمر تاخیر 

در یک نگاه می توان گفت که موتور زمانی روشن می شود که تایمر 
.تاخیری مدت زمان تاخیرش به پایان برسد
.مدار معادل گیت در روبرو رسم شده است

موتور زمانی روشن می شود که با یک تایمر تنظیم شده به زمان مناسب 
برسد

شمای این گیت در زیر آمده است

S1

K1

K1

M

:دیاگرام

Trg

Q

Ta

T T

تایمر فعال) )

توابع
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

توصیف تابع
1میرود تایمر فعال می شودخروجی 0به 1می شود وقتی تریگر از 1میشود خروجی فورا 1وقتی تریگر 

میشود وقتی ورودی تریگر تغییر وضعیت 0باقی می ماند وقتی تایمر به مقدار معین شده رسید خروجی 
.داد تایمر ریست می شود ورودی ریست می تواند تایمر و خروجی را ریست میکند

تایمر با خاموشی تاخیری
در یک نگاه می توان گفت که موتور زمانی خاموش می شود که تایمر 

.تاخیری مدت زمان تاخیرش به پایان برسد
.مدار معادل گیت در روبرو رسم شده است

موتور زمانی خاموش می شود که با یک تایمر تنظیم شده به زمان مناسب 
برسد

شمای این گیت در زیر آمده است

S1

K1

K1

M

تایمر فعال) )

Trg

Q

Ta T

R

T

:دیاگرام
توابع
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

تایمر با روشن وخاموش شدن تاخیری
:با یک نگاه به مدار می توان گفت که 

 بسته میشود کنتاکت با تاخیر بسته می شود 1وقتی کلید 
وموتور فعال می شود

 وقتی کلید باز می شود کنتاکت با تاخیر باز میشود و موتور 
.خاموش می شود

این تابع خاموش و روشن شدن با برنامه است
در زیر آمده استتابع شمای این 

توصیف تابع
باشد خروجی تا پایان این 1تریگر فعال می شود اگر تریگر در زمان تایمر بالا 1به 0تایمر بالا با تغییر از 

میشود تایمر پایین 0می ماند خروجی روشن شدن ورودی رابا تاخیر دنبال می کند وقتی ورودی 1زمان 
می 0باشد در طول تایمر پایین خروجی تا پایان زمان تایمر پایین 0فعال می شود اگر وضعیت تریگر 

.ماند

Trg

TL

Q

TH

:دیاگرام

K1

S1 K1

MK2

K2

توابع
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

نگهدارنده تاخیر روشن شدن

:توصیف تابع

میشود زمانی که تایمر به زمان تعیین 1فعال میشود و خروجی 1به 0تایمر با تغییر وضعیت تریگر از 
.شود تغییر تریگر دیگر تاثیری روی خروجی ندارد1میشود که ریست 0شده برسدخروجی زمانی 

با یک نگاه به مدار میتوان گفت که موتور زمانی روشن خواهد شد 
. که البته با یک تاخیر زمانی وقتی کلید فشاری فشرده شود

.کنتاکت بسته مسئول خاموش کردن موتور است
.تابع نگهدارنده تاخیر روشن شدن نام دارد

در زیر آمده استتابع شمای این 
S2

K1

K2

M

S1 K1 K1

K2

Trg

R

Ta

Q

T

توابع:دیاگرام
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

رله پاک کننده تولید کننده پالس
با یک نگاه می توان گفت که لامپ روشن خواهد بود تا زمانی که کلید 

بسته باشد
و تایمر فعال باشد

شمای این گیت در زیر آمده است
T1

S1

H1

T1

توصیف تابع
باقی می ماند 1فعال می شود و خروجی ! می شود تایمر  در لوگو1میشود خروجی فورا 1وقتی تریگر 

.خواهد رفت0به 1میشود خروجی فورا از  0وقتی  تایمر به زمان مشخص رسید خروجی 

Trg

Ta

Q

:دیاگرام
توابع
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

لبه تریگر رله پاک کننده

T1

S1

H1

T1

T1

توصیف تابع
یک خواهد شد تایمر در آن زمان روشن خواهد شد وقتی تایمر 1خروجی بعد از تغییر وضعیت تریگر به 

تغییر 1تغییر وضعیت خواهد داد خروجی پالس اگر تریگر دوباره به 0به زمان مورد نظر رسید خروجی به 
.یابد قبل از اتمام زمان مورد نظرتایمر ریست می شود و خروجی روشن می ماند

Trg

Ta

Q

T T

:دیاگرام

با یک نگاه می توان گفت که لامپ لامپ برای مدت مشخصی روشن 
می ماند

وقتی کلید بسته شود
شمای این گیت در زیر آمده است

توابع
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

تایمرهفته ای
خروجی به وسیله تاریخ روشن وخاموش شدن تعیین 

.میگردد
این تابع میتواند ترکیب های متفاوتی از روزهای مختلف 

.هفته را با هم ایجاد کند
شما می توانیدروز های مختلف هفته را فعال و انتخاب 

.کنید

چهارشنبه

دوشنبه

:توصیف تابع
وضعیت دارد که شما میتوانید 3هر هفته 

یک سیکل زمانی تعریف کنید و تایمرهای 
خاموش و روشن شدن را تعیین کنید

Mon Tue Wed Thurs Fri Sa So On Off

07 : 30 16 05Cam 1

08 :   00 12 00Cam 2

10 :   00 12 30Cam 3

توابع
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

Timer – yearly timer

:شرح عملكرد تايمر سالانه

هر تايمر سالانه شامل يك تايمر روشن كننده و 

با تعيين زمان .يك تايمر خاموش كننده است

روشن وخاموش شدن خروجي درروز مشخص

با انتخاب گزينه .شده روشن يا خاموش ميشود

"Every month "
خروجي تعيين شده درهر ماه در روز مشخص 

. شده روشن يا خاموش ميشود

Jan Feb Mar Apr May Jun Jul Aug Sep Oct Nov Dec

On 05.10 Off 10.20

15.05.200515.05.2005 08.11.2005 08.11.2005

توابع
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

Timer – pulse generator

با تعيين عرض پا لس 
onو off

. ميتوان خروجي را كنترل كرد

.نماد شماتيك اين تابع در زير آمده است .

“ timer pulse generator شرح عملكرد“
.بودن خروجي ميتواند در حد ثانيه يا دقيقه و يا ساعت باشد onو off 

EN“يك باشد خروجي  “در زماني كه "  inv ”با يك شدن پايه

.ميشود Toggle
. مدت زمان روشن يا خاموش بودن خروجي به طور كامل مستقل است

Diagram:

En

Q

pulse period / pause width

Inv

توابع
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

Timer – random generator

ثانيه يك10تا 0از صفر به يك خروجي با تاخيري بين  En با تغيير وضعيت پايه
دراين وضعيت. حداقل درطول زمان تاخير يك باشد En مي شود ،به شرط آنكه پايه

ثانيه 15تا0از يك به صفرتغيير وضعيت بدهد خروجي با يك تاخير بين En اگر پايه

صفر ميشود ، اگر در طول اين زمان پايهEnدوباره يك شود زمان صفر شدن 
.خروجي از اول شروع مي شود

با اعمال يك ژنراتور پالس به ورودي ، 

خروجي با يك تاخير تصادفي يك و صفر 

.ميشود

.نماد شماتيك اين تابع در زير آمده است

En

Q

max. ON delay / max. OFF delay

Q

Diagram:

توابع
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

Timer – stairway lighting switch

 با اعمال پالس به ورودي خروجي يك شده

15. وسپس بعد از زمان معيني صفر ميشود 

ثانيه قبل از صفر شدن خروجي در يك لحظه 

.كوتاه خروجي صفر و دوباره يك ميشود

 .نماد شماتيك اين تابع در زير آمده است

با اعمال اولين تريگر ، خروجي يك ميشود و با اعمال دومين تريگر زمان تاخيربراي 
ثانيه 1ثانيه قبل از صفر شدن خروجي به مدت 15.صفر شدن خروجي شروع ميشود

. صفر و دوباره يك ميشود

Ta

Trg

Q

T (OFF delay)

1s

15s

Diagram:

توابع



و راه اندازیاتوماسیون

!لوگو

Logic Module LOGO! 
A&D AS, 02/2006, Chart 35

© Siemens AG 2006  - Subject to change without notice

مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

:تايمر با دو كاركرد متفاوت 

1.Pulse switch with off delay
2.Switch

 .نماد شماتيك اين تابع در زير آمده است

Timer – multiple function switch

“Trg”  ثانيه  به پايه5با اعمال يك پالس با مدت زمان كمتر از

ثانيه صفر ميشود ، اما با اعمال يك پالس با زمان 5خروجي يك شده وسپس بعد از 
ثانيه خروجي يك شده و يك ميماند ، دراين وضعيت اگر ورودي يك وسپس 20حداقل 

.صفر شود خروجي نيز صفر ميشود 

Q

Trg

5s >20s

Diagram:

توابع
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

Counter – Up and Down counter

تريگر جهت شمارش كانتر را اعمال 1با توجه به مدار معادل مشاهده ميشود كه كليد
زماني كه تعداد . بالارو يا پايين رو بودن شمارنده را تعيين ميكند2ميكند و كليد

. يا بيشتر برسد خروجي يك ميشود5شمارش كانتر به 

Cnt با اعمال هر پالس با لبه مثبت به پايه

(Dir=1)  و يا يك رقم به سمت پايين(Dir=0) شمارنده داخلي يك رقم بالا

بعد از شمارش كانتر به ميزاني كه در. شمارش ميكند Parمشخص شده است ،

. خروجي يك ميشود 

.خروجي ونيز مقدار شمارنده داخلي صفر ميشوند R با يك شدن پايه

C1

S1

S2

+-

>=5

H1

Diagram:

Q

Cnt

Dir

R

1
2

3
4

5
6

5
4

3
2

3
4

5
6

0
1

2
3

Counter
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-مثال کاربردی 
PowerEn.ir

Counter – hours counter

Description of the function:

The hours counter monitors the input En. As long as the status of this input is 1, 
LOGO! determines the expired time OT and the time–to–go MN. LOGO! displays the 
times in parameter assignment mode. Output Q is set to 1 when the time–to–go MN 
= 0. Use input R to reset output Q and time–to–go counter to the specified value MI. 
The internal counter OT continues the count. Use input Ral to reset output Q and the 
time–to–go counter MN to the specified value MI. The internal counter OT is reset to 
0.

1
2

3
4

3
2

1
0

MN = MI

MN = 0

Q

Ral

En

3
2

1
0

R

OT

توابع
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-مثال کاربردی 
PowerEn.ir

Counter – threshold trigger

يك و صفر شدن خروجي با اعمال پالس به 

ورودي ومقايسه فركانس اين پالس با دو 

.فركانس مشخص، كنترل ميشود 

.نماد شماتيك اين تابع در زير آمده است

در ابتدا اگر خروجي صفر باشد براي يك شدن خروجي بايد فركانس پالس

ورودي كمتر از فركانس”on“باشد ودر اين وضعيت براي صفر شدن خروجي بايد 

.به ورودي اعمال شود  “off”  پالس با فركانس بيشتر از فركانس

On: on threshold. .  باشد 9999تا0000ميتواند بين 

Off: off threshold.  باشد9999تا0000ميتواند بين.

Gate time:       باشد95/99تا05/0ميتواند بين.

Diagram:

Fre

Q

gate 
time

Fre > On Fre > Off Fre < Off Fre < On

Fre =12 Fre = 5 Fre = 3 Fre = 5

On = 10   Off = 4توابع



و راه اندازیاتوماسیون

!لوگو

Logic Module LOGO! 
A&D AS, 02/2006, Chart 39

© Siemens AG 2006  - Subject to change without notice

مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

Analog – analog threshold trigger

خروجي زماني يك ميشود كه مقدارورودي 

آنالوگ از آستانه روشن شدن بيشتر شود 

و هنگامي كه مقدار ورودي آنالوگ از 

آستانه خاموش شدن كمتر شود خروجي 

آستانه روشن وخاموش . صفر ميشود 

باشد در ضمن 1000تا0شدن ميتواند بين 

.خروجي با ضريب بهره تقويت ميشود

Diagram:

توابع
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-مثال کاربردی 
PowerEn.ir

Analog – analog comparator

دراين مقايسه گر تفاوت دو ورودي 

آنالوگ AxوAxمحاسبه شده وهنگامي كه

تفاوت اين دو سيگنال از مقدار آستانه 

تجاوز كند خروجي يك ميشود و اگر مقدار 

تفاضل دو ورودي از مقدار آستانه كمتر  
.  شود خروجي صفر خواهد شد

Diagram:

توابع
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-مثال کاربردی 
PowerEn.ir

Analog - analog differential trigger

يك ورودي آنالوگ به پايه Axاعمال ميشود

كه اين سيگنال با يك مقدار مشخص مقايسه 

خروجي بر اساس مقادير آستانه . ميشود 

روشن شدن (on)ونيز سيگنال تفاضلي

.صفر يا يك ميشود)   (

.خروجي با ضريب بهره تقويت ميشود
Diagram:

Timing diagram A: Function with negative differential delta value

Timing diagram B: Function with positive differential delta value

توابع
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-مثال کاربردی 
PowerEn.ir

Analog – analog watchdog

هنگامي كه پايه ”En“از صفر به يك تغيير 

وضعيت بدهد مقدار سيگنال وروديAxدر اين 

لحظه ذخيره ميشود كه ”Aen“نام دارد ، با 

اضاف و كم كردن يك مقدار ثابت از”Aen“دو 

-Aen”و“   +Aen“به دست  مقدار ثابت“

اگر پايه.مي آيد  ”En“يك باشد وسيگنال 

“Aen+   “و”Aen- ”Ax“از محدوده “

:Diagram.تجاوز كند خروجي يك مي شود

توابع
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-مثال کاربردی 
PowerEn.ir

Analog – analog amplifier

Ax اين تابع يك سيگنال ورودي را از پايه

دريافت و آن را با ضريب بهره تقويت مي كند 

سپس يك مقدار آفست نيز به آن اضافه مي كند

.اين مقدارنهايي به دست ميآيد AQ در خروجي

توابع
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-مثال کاربردی 
PowerEn.ir

Analog – PI controller

Description of the function:

If the input A/M is set to 0, then the special function 
sets output AQ with the value that is set with 
parameter Mq. If the input A/M is set to 1, then 
automatic mode commences. As an integral sum the 
value Mq is adopted, the controller function begins the 
calculations of the formulas. 
The updated value PV is used within the formulas. 
Updated value PV = (PV * gain) + offset
If the updated value PV = SP, then the function
does not change the value of AQ. With a disturbance, 
AQ continues to increase / decrease until the updated 
value PV again corresponds to SP. The speed with 
which AQ changes depends on the parameters KC and 
TI. If the input PV exceeds the parameter Max, then 
the updated value PV is set to the value of Max. If the 
PV falls short of the parameter Min, then the updated 
value PV is set to the value of Min. If the input R is set 
to 1, then the AQ output is reset. As long as R is set, 
the input A/M is disabled. The sampling time is fixed at 
500 ms.

توابع
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-مثال کاربردی 
PowerEn.ir

Analog – PI controller

Parameter:
Sensor: Type of sensor used
Min: Minimum value for PV
Max: Maximum value for PV
Gain: Gain for PV
Offset: Zero offset for PV
SP: Set point assignment
Mq: Value of AQ in manual mode 
Parameter sets: applied presets for  
KC, TI and Dir
KC: Gain
TI: Integral time
Dir: Action direction of the controller 
Number of decimal places in 
message text

توابع
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-مثال کاربردی 
PowerEn.ir

Analog – PI controller

parameter sets:
pl“پارامترهاي از قبل controller” جهت ساده كردن استفاده از تابع

.در زير آورده شده است KC,TI,Dir آماده شده براي

.پارامترها به صورت دستي نيز مي توانند تعيين شوند 

Parameter sets “user defined”

Parameter 
Set

Applications
Parameter 

KC

Parameter 
TI (s)

Parameter 
Dir

Temperature
fast

Temperature, low temperature 
control for small rooms; small 
volumes

0.5 30 +

Temperature
slow

Heater, ventilation, temperature, 
low temperature control for large 
rooms, large volumes

1.0 120 +

Pressure 1
Fast pressure change,
compressor control

3.0 5 +

Pressure 2
Slow pressure change,
Differential pressure control
(flow control)

1.2 12 +

Filling level 1
Barrel, container filling without 
downpipe/ drain

1.0 1 +

Filling level 2
Barrel, container filling with 
downpipe/ drain

0.7 20 +

توابع
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-مثال کاربردی 
PowerEn.ir

Analog – ramp

Description of the function:

At the analog output, this special function starts up one 
of two levels or offset. Here you can set how quickly the 
level should be reached.
If the input En is set, then the function issues the value
StSp + offset at output AQ for the first 100 ms.
Then, depending on the connection of Sel, the function
runs from value StSp + offset to either level 1 or level 2 at 
the acceleration set in Rate.
If the input St is set, the function runs to the value StSp + 
offset at the acceleration set in Rate. Then the function 
issues the value StSp + offset at output AQ for 100 ms.
Finally offset is issued at output AQ.
If the input St is set, the function can only be restarted 
once the inputs St and En have been reset. If input Sel
has been changed, depending on the connection of Sel, 
the function runs from level 1 to level 2 or the other way 
round. If the input En is reset, the function immediately 
issues offset  at output AQ. The analog value at the 
output is recalculated every 100 ms.

توابع
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-مثال کاربردی 
PowerEn.ir

Analog - ramp

Parameter:
Gain: Gain for AQ in message text
Offset: Zero offset for AQ in message 
text
L1 and L2: Levels to be reached 
Maximal output value: Maximum value 
that must not be exceeded under any 
circumstances
Start/ stop offset: value that is issued for 
100ms in addition to parameter
offset after starting the function
and before reaching the offset value 
(prompted by input St). This parameter 
is intended for controlling motors.
Change speed: Acceleration with which 
level 1, level 2 or offset is reached. 
Steps/ second are input.
Number of decimals

توابع
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-مثال کاربردی 
PowerEn.ir

Analog - ramp

Diagram:

توابع
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-مثال کاربردی 
PowerEn.ir

Analog – analog MUX

ويا  v1تا v4خروجي اين تابع وي   ژه يكي از چهار مقدار آنالوگ از پيش تعيين شده

اگر پايه.صفر خواهد بود  ”En“يك باشد يكي از چهار مقدار آنالوگ با توجه به   

و اگر پايهظاهر ميشود ”En“صفر باشد خروجي  AQ در خروجيS1وS2 مقادير

.را به دلخواه انتخاب كرد V1تاV4 ميتوان مقاديرآنالوگ.نيز صفر خواهد بود

توابع
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-مثال کاربردی 
PowerEn.ir

Miscellaneous – latching relay

k1با  با توجه به مدار معادل مشاهده مي شود كه كويل

.وصل ميشود  S1كليد

.نماد شماتيك اين تابع در زير آمده است
S2

K1 M

S1 K1 K1

K2

. ميكند  Reset را Setو ورودي Rخروجي Qرا Q  خروجيSورودي

S

R

Q

Diagram:

توابع
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-مثال کاربردی 
PowerEn.ir

Miscellaneous – pulse relay

Trgخروجي از يك به صفر يا از صفر به يك تغيير   با دادن هر پالس به ورودي

.خروجي را صفر كرد  R  ميتوان با اعمال يك پالس به پايه. وضعيت ميدهد

با  H1با توجه به مدار معادل مشاهده مي شود كه لامپ

به عبارت . روشن يا خاموش ميشود S1ياS2 كليدهاي

ديگر يك پالس S2ياS1باعث روشن وخاموش شدن
كوتاه

.لامپ ميشود

.نماد شماتيك اين تابع در زير آمده است
K1

S1 K1S2

H1

Trg

R

Q

Diagram:
توابع
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-مثال کاربردی 
PowerEn.ir

Display of a configured message text in run 
mode.

Symbol for this function is         . 

Miscellaneous – message text

Description of the function:

With a 0 to 1 transition of the  input signal 
and when the system is in RUN, the 
corresponding message text is output to
the display. The message text is hidden 
when the status of the signal at input 
changes from 1 to 0. When multiple 
message text functions are triggered with
En=1, the message text that has the 
highest priority is shown. Changing 
between the standard display and the 
message texts display is possible by using 
the keys and            .  If “acknowledge 
message” is chosen, the respective 
message text will be hidden by pressing 
any key on LOGO!, if En=0.

LOGO
OK

1234

s

Motor on

ESC

I :
0..  123456789
1..0123456789
2..01234

Alarm!
Current Temp

97  °C

توابع
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-مثال کاربردی 
PowerEn.ir

Miscellaneous – softkey

Diagram:

اين تابع عملكردي شبيه pushbuttonيا كليد 

Enاگرپارامتر  بااعمال سيگنال به پايه. دستي دارد

“set” باشد خروجي “on” در وضعيت“switch”

:ميشود “Reset” خروجي در سه حالت زير.ميشود

.از صفربه يك  En 1.بعد ازتغيير وضعييت پايه

.زماني كه دوره يك بودن خروجي تمام شود . 2

“switch” در پارامتر “off” .وقتي كه وضعيت 3

.  انتخاب شده باشد

توابع
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-مثال کاربردی 
PowerEn.ir

Miscellaneous – shift register

اين تابع يك شيفت رجيستر است كه داراي 

. هشت بيت حافظه مي باشد

Trgمقادير  با اعمال پالسهاي متوالي به پايه

حافظه هاي S1تاS8به خروجي انتقال ميابند 

حاف اگر پالسهاي ورودي قدرت كافي نداشته 
باشند شيفت دادن محتواي S1تاS8از اول 

.شروع ميشود 

.نماد شماتيك اين تابع در زير آمده است

Diagram:

Shift 
up

Shift 
down

S4 = Q (example)

توابع
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-مثال کاربردی 
PowerEn.ir

عملکرد دستگاه

Connect LOGO! to the power supply 
and switch it on. The display now 
shows you this message. 

Press ESC to get to the main 
menu. 

آيا شما يك مدار طراحي كرده ايد ؟

آيا ميخواهيد آن را به LOGOواردكنيد؟

چگونه اين كار را انجام ميدهيد؟

LOGO!

No Program

Press ESC

s

OKESC

LOGO!

> Program..

Card..

Setup..

Start

s

OKESC

عملکرد دستگاه
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-مثال کاربردی 
PowerEn.ir

Main menu / programming menu

Here you can also move the ”>” cursor by pressing        
. 

Move the ”>” cursor to ”Edit..” and confirm with 

.
In the next sub-menu please chose Edit Prg. You 
are now in programming menu.

OK

Press        to select all output, marker and open 
connectors. 

The following applies when you edit a circuit: ....

The first character in the first line is the ”>” 
cursor. Press          to move the ”>” cursor up and 
down. 

Move it to ”Program..” and confirm with         . 

LOGO! opens the programming menu.

OK

LOGO!

> Program..

Card..

Setup..

Start

s

OKESC

LOGO!

> Edit..

Clear Prg

Password

s

OKESC

LOGO!

> Edit Prg

Edit Name        

AQ in Stop

Memory?

s

OKESC

LOGO!

s

OKESC

B1    Q1

عملکرد دستگاه

Cursor : نشانه متحرك صفحه نمايش
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PowerEn.ir

LOGO! - rules for operation

I

I1

Q

Q1

Q

Q1

&

B001

Q

Q2

&

B002

1. You have to create your 
circuit by working from 
the output to the input. 

2. You can connect an 
output to several inputs.

3. You can’t  connect an output 
to an upstream input within 
the same path (recursion). 

B002

>

&

B002

عملکرد دستگاه
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4. You can move the cursor with              if it appears in the 
form of an underscore ( _ ) :

LOGO! - rules for operation

Q1B01Q1B01Q1

B02
B01

I1

x

&

Q1

B02
B01

I1

x

&

B01

B02

I3

1

xx

عملکرد دستگاه
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-مثال کاربردی 
PowerEn.ir

LOGO! - rules for operation

 Confirm with        .

 Press         to return to the 
previous step.

OK

ESC

OK
Q1GF

Q1SF

Q1Co

>1

Q1

B1

&

5. When the cursor appears as a solid square ( ), press with
to select a connector (Co), a basic function (GF) or a

special function:

OKOKOK

In1
In2

In3
In4

Q1

B1

&
In1
In2

In3
In4

Q1

B1
In1
In2

In3
In4

Q1

B1

&
In1
In2

In3
In4

Q1

B1

&
Co

In2

In3
In4

Q1

B1

&
I1

In2

In3
In4

Q1

B1

&
I2

In2

In3
In4

عملکرد دستگاه
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تفسير ميکند OR  را يک گيت2و 1لوگو موازی شده دو کليد

اولین برنامه لوگو شما

به کار می افتد s2 يا s1 بار با

.موازي است را بررسي مي كنيم “switch”  اكنون مدار زير كه شامل دو

>1
I1
I2

X

Q1

راه حل لوگو

X

S1 S2

K1

K1

E1

مدار

• • •

•

• •

عملکرد دستگاه
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سیم کشی

وصل 2به ورودی 2و کليد 1به ورودی 1کليد 
متصل است1است و بار به خروجی 

در ابتدا روی.حال برنامه را به لوگو وارد ميکنيم

نشان داده ميشود علامت1صفحه نمايشگر خروجی 
.چشمک زن موقعيت کنونی ما را مشخص ميکند

•

L1

N

S1

LOGO! 230RC

OK

Q1

I1 I2 I3 I4 I5 I6L1 N

Q1 Q2 Q3 Q4

S2

L1

N

s

I7 I8

••

ESC

•

E1

عملکرد دستگاه
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ورودی برنامه

نشانگر به 2با فشاردادن کليد مشخص شده در شکل 
سمت چپ حرکت ميکند

کليد       فشاردهيد تا وارد مرحله ويرايش شويد

علامت چشمک زن به شکل     در می آيد

با فشردن        يکی از گزينه های زير را انتخاب کنيد

(Co) اتصالات

(GF) توابع ابتدايی

(SF)توابع ويژه

LOGO!

s

OKESC

Q1

LOGO!

s

OKESC

Q1

LOGO!

s

OKESC

Co    Q1

عملکرد دستگاه

1

2

3

OK
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را انتخاب وکليد       را فشاردهيد (GF)

ورودی برنامه

اولين بلوک است AND, (GF) در

با فشردن کليدهای       يکی از گزينه های زير را 
انتخاب ميکنيم

 AND 
 AND (edge)  
 NAND 
 NAND (edge)
 OR
 NOR
 XOR
 NOT

را انتخاب وبا        تاييد کنيد OROK

LOGO!

s

OKESC

GF    Q1

LOGO!

s

OKESC

Q1

B1

>1
In1
In2
In3
In4

LOGO!

s

OKESC

Q1

B1

>1
In1
In2
In3
In4

عملکرد دستگاه

OK
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ورودی برنامه

به هر بلوک به صورت اتوماتيک شماره ای 

.اختصاص داده ميشود
.حال ما بايد وروديهای اين بلوک را تنظيم کنيم

.کليد        را فشار دهيد

علامت چشمک زن به صورت     نمايش داده ميشود

با کليدهای       يکی از گزينه های زير را انتخاب 
ميکنيم

 (Co)
 (GF)
 (SF)

را انتخاب و      را فشار دهيد (Co)

. است1ورودی : (Co)  اولين انتخاب از

کليد        را فشار دهيد

.             

OK

OK

OK

LOGO!

s

OKESC

Q1

B1

>1
Co
In2
In3
In4

LOGO!

s

OKESC

Q1

B1

>1
I1
In2
In3
In4

LOGO!

s

OKESC

Q1

B1

>1
I1
In2
In3
In4

عملکرد دستگاه
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ورودی برنامه

را به اين بلوک وصل کنيم 2حالا ميخواهيم ورودی 

را فشاردهيد  

را فشاردهيد Co تا رسيدن به

حالا برای تاييد       را فشاردهيد

را فشار دهيد و سپس2تا رسيدن به  ورودی 

با         تاييد کنيد

در اينجا ما به دو ورودی ديگر احتياج نداريم اين 
.حالت را در لوگو با علامت ضربدر نشان ميدهيم 

به طريق مشابه بالا  روی دو ورودی ديگر ضربدر 

.ميگذاريم

OK

OK

OK

LOGO!

s

OKESC

Q1

B1

>1
I1
Co
In3
In4

LOGO!

s

OKESC

Q1

B1

>1
I1
I2
In3
In4

LOGO!

s

OKESC

Q1

B1

>1
I1
I2
X
X

عملکرد دستگاه
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شروع برنامه

!برنامه تمام است

با حرکت دادن علامت چشمک زن بوسيله کليدهای 

مشخص شده در شکل اول ميتوانيم روی برنامه 
.حرکت کرده و برنامه را مرور کنيم 

با فشردن کليد       از حالت برنامه نويسی خارج شده 

و به منو بازمی گرديم
برنامه به صورت اتوماتيک در حافظه داخلی 

.ذخيره ميشود( E2PROM)

جهت اجرای برنامه با        به منوی اصلی برگشته و  
با         Startرا انتخاب ميکنيم

ESC

ESC

OK

LOGO!

s

OKESC

Q1

B1

>1
I1
I2
X
X

LOGO!

LOGO!

> Edit Prg

Edit Name        

AQ in Stop

Memory?

s

OKESC

> Edit..

Clear Prg

Password

s

OKESC

LOGO!

Program..

Card..

Setup..           

>  Start

s

OKESC

عملکرد دستگاه
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حالت اجرای لوگو

.صفحه های زير را نمايش ميدهد RUN لوگو در مد

1

1

1
1

.اين مثالی بود که با هم مرور کرديم

.قرار ميگيرد“ 1”را بزنيم ورودی اول در حالت 1وقتی کليد 

.وقتی خروجی يک است ولتاژ ميرسد

حالات وروديها

است1حالت ورودی اول 

است0حالت ورودی اول 

حالات خروجيها

است1حالت خروجی 

است0حالت خروجی 

L1

S1
=1

S2
=0

I :     
0..      23456789
1.. 0123456789
2.. 01234

N

Q1

=1

Mon 09:14

2006-02-21

Q :
0..     23456789
1..0123456

11

• • •

•

عملکرد دستگاه
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حالت پارامتر گذاری لوگو

پارامترگذاری توابع

When speaking of parameterization, 
we refer to the
configuration of functions.
You can configure the parameters 

 in programming mode

or

 in parameter assignment
mode

You can configure:

 the delay times of timer functions

 the switching times of timer switch

 counter thresholds

 the monitoring interval for a hour 
counter

 on and off threshold for a trigger 
threshold

 and some other functions

To get to configuration mode press                 
in RUN mode, set the cursor 

to Set Param and confirm with          .
ESC

OK

LOGO! 12/24 RC

LOGO! 

OKESC

Stop

Set Param

Set..

Prg Name

>

s

LOGO! 12/24 RC

LOGO! 

OKESC

I :       

0..  123456789

1..0123456789

2..01234

s

عملکرد دستگاه
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حالت پارامتر گذاری لوگو

:انتخاب بلوک

.درمد بارامتر گذاری بلوک مورد نظر را انتخاب کنيد

.جهت تاييد بلوک انتخابی        را فشار دهيد

نشانگر به اولين بارامتری که ميتواند انتخاب شود 
.انتقال مييابد 

مقدار بارامتر را با فشردن          ميتوان تغيير داد 

.سبس با فشردن        مقدار بارامتر را تاييد ميکنيم 

بلوک مورد نياز بعدی را ميتوان توسط        انتخاب 
.کرده و ادامه داد

OK

OK

LOGO!LOGO!

LOGO!

B2

T    =10:00s

Ta  =00:00

s

OKESC

B2

T    =15:00s

Ta  =00:00

s

OKESC

B2

T    =15:00s

Ta  =00:00

s

OKESC

LOGO!

LOGO!

عملکرد دستگاه
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.رافشار دهيد  RUN برای بازکشت به مد

حالت پارامتر گذاری لوگو

.برای بازگشت به منو       را فشار دهيد  ESC

ESC

LOGO!LOGO!

LOGO!

B2

T    =10:00s

Ta  =00:00

s

OKESC

> Stop          

Set Param

Set..             

Prg Name

s

OKESC

I :       
0..  123456789
1..0123456789
2..01234

s

OKESC

LOGO!

LOGO!

عملکرد دستگاه
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برنامه کامپیوتری لوگو

Windows Look and Feel 
 e.g. context menu, toolbar

Create the control programs by „drag and drop“
 Control programs „drawing“ –

directly on a PC in FBD or LAD

Testing of control programs
 Offline simulation

with status for each function 
(color change)

 Online test with color change 
for each function
and 30 actual values

Professional print and 
documentation functions
Device selection
 0BA0, 0BA1, 0BA2, 0BA3, 0BA4, 0BA5

with function check

Additionally on the CD ROM: 

Manual and 32 complete, usable examples

A&D AS, 07/2003, Chart 72
© Siemens AG 2003  - Änderungen vorbehaltenc

5ويرايش ! نرم افزار لوگو
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PowerEn.ir

نصب برنامه لوگو

سی دی لوگو را در کامپيوتر قرار دهيد
.را انتخاب کنيد start.html پس از ورود

2.

3.

5ويرايش ! نرم افزار لوگو
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PowerEn.ir

نصب برنامه لوگو

Start.html توابع
زبان7انتخاب مستقيم 

نصب برنامه
اجرای مستقيم برنامه از سی دی

انتخاب مسايل نمونه از سی دی
نصب برنامه های مورد نياز

5ويرايش ! نرم افزار لوگو
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PowerEn.ir

نصب برنامه لوگو

آغاز نصب برنامه

5ويرايش ! نرم افزار لوگو
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PowerEn.ir

نصب برنامه لوگو

را انتخاب کنيد next پس از انتخاب زبان و تاييد در پنجره بعدی نيز

5ويرايش ! نرم افزار لوگو
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نصب برنامه لوگو

برنامه به صورت پيش فرض در آدرس زير نصب می شود
C:\Program Files\Siemens\LOGOComfort_V5

اگرمی خواهيد آدرس را تغيير دهيد 
Browse

هروقت با آدرس نوشته شده در کادر موافق بوديد
Next

5ويرايش ! نرم افزار لوگو
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نصب برنامه لوگو

آيکون برنامه روی دسک تاپ              است
را انتخاب کنيد Ok

5ويرايش ! نرم افزار لوگو
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نصب برنامه لوگو

می توانيد با انتخاب آيکون برنامه روی دسک تاپ آن را اجرا کنيد.نصب برنامه تمام است

5ويرايش ! نرم افزار لوگو
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

نگاهی کلی به برنامه لوگو

Title bar

Menu bar

Symbol bar for 
program installation

Switch to selecting mode

Text fields for additional 
comments

For a better overview
separation of connections

Drawing of connection lines

Display connectors (Co)

Display basic functions (GF)

Display special functions (SF)

Offline simulation

Standard Windows PC -> LOGO! LOGO! -> PC!

Online test

Tree structure for fast choice 
of all generation elements

5ويرايش ! نرم افزار لوگو



و راه اندازیاتوماسیون

!لوگو

Logic Module LOGO! 
A&D AS, 02/2006, Chart 81

© Siemens AG 2006  - Subject to change without notice

مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

راهنمایی

با کليک موس روی هر موضوع 
دلخواه ميتوانيد جزئيات آن را ببينيد

از طريق زير ميتوانيد راهنمايی دريافت کنيد
Help -> Content

5ويرايش ! نرم افزار لوگو



و راه اندازیاتوماسیون
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

راهنمایی مستقیم

برای دريافت راهنمايی مستقيم روی 
تابع مورد نظر کليک راست کنيد

5ويرايش ! نرم افزار لوگو



و راه اندازیاتوماسیون
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

راهنمایی مستقیم

داز مسير زير هم می توانيد راهنمايی مستقيم دريافت کني
Help -> Context-sensitive Help

5ويرايش ! نرم افزار لوگو
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

ارتقاء-راهنمایی

از طريق زير ميتوانيد برنامه خود را ارتقا 
دهيد و قابليت های جديد به آن اضافه 

(مثلا زبانهای جديد)کنيد
Help -> Update Center.

5ويرايش ! نرم افزار لوگو
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

وظایف نمونه لوگو

کنترل مخزن آب

(Q1) افت کند منبع آب آشاميدنی (I1) وقتی سطح آب به زير

I2 وقتی سطح آب به. به طور اتوماتيک شروع به کار ميکند

.برسد منبع آب به طوراتوماتيک قطع می شود

P

I3 (Pump OFF)

I1 
(drinking water     
supply ON)

I2
(drinking water            
supply OFF)

I4 
(Pump OFF)

Q1 
(drinking water supply)

5ويرايش ! نرم افزار لوگو
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

(CO) واردکردن اتصالات :قدم اول

برای انجام کار به چند ورودی و خروجی احتياج داريم؟

به وسيله ساختار درختی سمت چپ برنامه ميتوانيد سريعا همه بلوک

های ورودی و خروجی و تمام توابع و ملزومات ديگر را انتخاب کنيد

و آنها را در جای خود قرار دهيد

بعد از انتخاب المان مورد نظرعلامت زير ظاهر می شود

المان در انجا جای ميگيرد.به محل مورد نظر رفته و کليک چپ کنيد

1.

2.

5ويرايش ! نرم افزار لوگو
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

وارد کردن توابع پایه: قدم دوم 

چه توابع ساده ای برای حل مساله مورد نياز می باشد؟

در صفحه1و خروجی 2و 1بعد از قرار دادن هردو ورودی 
مطابق آنچه گفته شد.احتياج داريم  NOT يک تابع ساده

ان را از سمت چپ انتخاب کرده و در جای خود قرار دهيد

1.

5ويرايش ! نرم افزار لوگو.2
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

وارد کردن توابع خاص: قدم سوم 

به چه توابع خاصی نياز داريم؟

نيز نياز داريم  latching relay 1به يک.

2.

5ويرايش ! نرم افزار لوگو
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

Step 3: Insert special functions (SF)

.را معکوس کرد latching relayپايه NOT  در اين برنامه می توان به جای استفاده از

با کليک راست می توان با انتخاب گزينه اول پايه را معکوس کرد

5ويرايش ! نرم افزار لوگو



و راه اندازیاتوماسیون
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

اتصال: قدم چهارم

حالا بايد بلوکها را به هم متصل کرد

با نشانگر ماوس می توان به صورت مستقيم اتصال ها را در هنگام جايگزينی بلوکها برقرار کرد

.در غير اين صورت بايد ابزار           را انتخاب کنيد

نشانگر ماوس را به کنار پايه اتصال بلوک منتقل کنيد و کليک چپ کنيد و بدون برداشتن دست خود 

از روی ماوس آن را به پايه ای که می خواهيد برده و ان را رها کنيد 

1.

2.
5ويرايش ! نرم افزار لوگو
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

اتصال: قدم چهارم 

:                                      برای کامل کردن مدار کنترلی بايد بلوک ها را به يکديگر متصل کنيد

اما اگر در وضعيت .به طور معمول ميتوانيد بعد از قرار دادن بلوک آن را توسط نشانگر وصل کنيد

.ديگری قرار داريد بايد ابزاری را برای متصل کردن انتخاب کنيد

و ( يک جعبه کوچک آبی رنگ نشان داده می شود)اکنون نشانگر را روی پايه اتصال حرکت دهيد 

همزمان که کليک را فشار می دهيد نشانگر را به سمت پايه ای که .کليک چپ موس را فشار دهيد

همين کار . اتصال نمايان می شود.ميخواهيد اتصال دهيد، حرکت دهيد سپس کليک موس را رها کنيد

. را برای ديگر اتصال ها تکرار کنيد

1.

2.
5ويرايش ! نرم افزار لوگو
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

اضاف کردن متن                                           : قدم پنجم 

.با اضاف کردن متن بر روی پس زمينه ، برنامه شما قابل فهم تر می شود
:برای اين کار راههای متفاوتی در ساختار برنامه قرار دارد

قرار دادن عبارت در هر بلوک برنامه توسط منوی 
(کليک چپ موس)متن

5ويرايش ! نرم افزار لوگو
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

قرار دادن زمينه متن                                     : قدم پنجم 

A

با قرار دادن يک زمينه دارای متن

1.

2.

4.

3.
5ويرايش ! نرم افزار لوگو
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

نام گذاری اتصالات                                      : قدم ششم 

.          به منظور خوانا تر شدن برنامه ، می توان نامهايی را برای ورودی و خروجی ها در زمينه متن قرار داد

5ويرايش ! نرم افزار لوگو
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

جابه جا کردن المانها: قدم هفتم 

. برنامه کنترلی با قرار دادن ساختار بلوک ها و اتصال آنها کامل می شود Placed objects such as function 
blocks, lines, and text fields can be moved accordingly.

اين ابزار       برای جابجايی به کار 
.می رود

5ويرايش ! نرم افزار لوگو
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

رديف کردن                                               : قدم هشتم 

اين دکمه        برای رديف کردن بلوک های انتخاب شده به 
.صورت عمودی می باشد 

.                                         برای طراحی بهتر می توانيد بلوک ها را در رديف های افقی يا عمودی قرار دهيد 

برای رديف کردن بلوک ها ، ابتدا بايد آنها را انتخاب 
.کنيد

5ويرايش ! نرم افزار لوگو
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

پارامتر گذاری بلوک ها: قدم نهم 

.                                                        در اينجا می توانيد تنظيمات مربوط به هر تابع مخصوص را انجام داد

بلوک تابع را انتحاب کنيد ، با زدن کليک راست موس گزينه 

.منو را انتخاب کنيد

.دو بار کليک چپ موس را بر روی بلوک تابع فشار دهيد

در پيکربندی ،آدرس ديگری می تواند برای هر 

تنها  . ورودی و خروجی يک بلوک ، معين شود

ورودی ها و خروجی هايی  را در بر می گيرد که 

.  هنوز در برنامه کنترلی نامگذاری نشده اند

5ويرايش ! نرم افزار لوگو
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

پارامتر گذاری بلوک ها: قدم نهم 

.ضمنأ اين امکان هم وجود دارد که نشانه همه بلوک ها را چک و يا عوض کنيم

5ويرايش ! نرم افزار لوگو
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

قالب بندی متن ها: قدم دهم 

.  متن ها و عبارات توسط کاربر ، می تواند تغيير کند قالب بندی زمينه

5ويرايش ! نرم افزار لوگو
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

اسناد و مدارک: قدم يازدهم 

.برای مستند سازی برنامه ، تمام اتصالات بکار برده شده ، توابع مخصوص و توابع اصلی  قابل نمايش می باشد

5ويرايش ! نرم افزار لوگو
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

اسناد و مدارک: قدم يازدهم 

اطلاعات بيشتری در باره اسناد و مدارک برنامه را می توان در پنجره اطلاعات مشاهده کرد که به صورت يک دکمه پيش 
.فرض قرار داده شده است

شما می توانيد در هر زمانی توسط منوی                           به 

.پنجره اطلاعات دسترسی پيدا کنيد

در پنجره اطلاعات مرجع استفاده شده در برنامه ، با زمان و تاريخ 

.آن نمهيش داده می شود . 

5ويرايش ! نرم افزار لوگو

View -> Info Window
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

اسناد و مدارک: قدم يازدهم 

.اطلاعات و محيط برنامه را می توان مطابق شکل زير مشاهده کرد

5ويرايش ! نرم افزار لوگو
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

اسناد و مدارک: قدم يازدهم 

The program including the entered plant data can be viewed from the attribute 
window under File -> Print preview.

5ويرايش ! نرم افزار لوگو
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

اسناد و مدارک: قدم يازدهم 

شما می توانيد اسناد و مدارکی را که می خواهيد چاپ کنيداز طريق گزينه                     در پنجره                  

توسط  پيش فرض قرار دادن  دياگرام مداری، ليست پارامترها و ليستی شامل نام اتصالات انتخاب خواهد . انتخاب کنيد
. شد

5ويرايش ! نرم افزار لوگو

Properties…print preview
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

اسناد و مدارک: قدم يازدهم 

اين امکان وجود دارد تا دياگرام مدار را به صفحات بزرگتر تقسيم کرد

5ويرايش ! نرم افزار لوگو
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مقدمه

نصب و سیم بندی

توابع

عملکرد دستگاه

5ویرایش ! نرم افزار لوگو

-مثال کاربردی 
PowerEn.ir

اسناد و مدارک: قدم يازدهم 

.در ضمن پياده سازی برنامه بر روی صفحات مختلف ممکن است لازم شود که خطوط اتصال جدا شوند

تداخل ها به وضوح توسط شماره صفحه ، شماره بلوک و پايه . اتصالات را می توان به سادگی توسط انتخاب گزينه برش، از هم جدا کرد

.   ورودی برپسب گذاری شده است

5ويرايش ! نرم افزار لوگو
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-مثال کاربردی 
PowerEn.ir

تست کردن برنامه: قدم دوازدهم 

. بعد از پيکر بندی و اسناد و مدارک ، قدم بعدی، تست برنامه توسط شبيه ساز است

.  اما هنوز شما بايد عملکرد برنامه خود را مطابق آنچه انتظار داريد چک کنيد. اکنون شما می دانيد که برنامه می تواند در لوگو اجرا شود

شما می توانيد به راحتی مقادير ورودی ها ، نحوه عملکرد قسمت های مختلف را از .شايد قصد داشته باشيد تا پارامتر هايی  را عوض کنيد

.   طريق محاسبه و آنچه در خروجی آنها داريد، با هم مقايسه کنيد

5ويرايش ! نرم افزار لوگو
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-مثال کاربردی 
PowerEn.ir

تست کردن برنامه: قدم دوازدهم 

.يک ابزار بسيار کارامد برای چک کردن برنامه موجود می باشد

اين ابزار            را هنگامی 

انتخاب کنيد که می خواهيد برنامه 

با انجام عمليات . را چک کنيد

شبيه ساز يک خط ابزار برای 

مشاهده و نحوه عملکرد خروجی 

.  و ورودی ها انتخاب می شود

با کليک کردن بر روی خط ابزار 

و يا بر روی ورودی ها در 

دياگرام مدار ، ميتوانيد وضعيت 

.  ورودی ها را عوض کنيد

سيگنالها ی موجود در خطوط 

اتصال را می توان با تغيير دادن 

(لبه پايين سيگنال)رنگ از آبی 

لبه بالا ی )به رنگ قرمز 

اين کار باعث .نشان داد( سيگنال

می شود تا خطا يابی بسيار آسان 

. شود

5ويرايش ! نرم افزار لوگو
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-مثال کاربردی 
PowerEn.ir

تست کردن برنامه: قدم دوازدهم 

.از مزايای تست کردن برنامه اين است که هر ورودی می تواند به يک سوييچ اختصاص داده شود

شما می توانيد . به يک سوييچ خاص اختصاص داد( کليک راست موس) هر يک از ورودی های بلوک ها را توسط منوی متن ورودی بلوک 

اگر کليد ورودی های فرکانسی را انتخاب کنيد ، . از بين کليدهای فشاری و ورودی های فرکانسی ،در ورودی های ديجيتال انتخاب کنيد

با ورودی آنالوگ مقدار رنج و مقدار شروع را می توان تنظيم . فرکانس های شبيه سازی شده می توانند در فرکانس های مختلفی تنظيم شود

. تمام اين تنظيمات در منوی                                              قرار دارد. کرد

5ويرايش ! نرم افزار لوگو

Tools -> Simulation parameters.
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-مثال کاربردی 
PowerEn.ir

قرار دادن کلمه رمز: قدم سيزدهم 

.برای محافظت از برنامه خود می توانيد يک عدد ده رقمی را به عنوان کلمه رمز قرار دهيد

به طوری که بدون نياز به کلمه رمز ! اين کلمه رمز برنامه شما را فقط در لوگو محافظت می کند

برای پاک کردن کلمه رمز قبلی  وارد گزينه                  . می توانيد آن را پاک و يا مشاهده کنيد

.شويد و                         را خالی بگذاريد

کلمه رمز زمانی گم می شود که کلمه رمز سه بار ! برای آنکه بتوانيد دوباره از لوگو استفاده کنيد

.  در اين حالت برنامه به صورت خودکار پاک می شود. به طور اشتباه وارد شود

5ويرايش ! نرم افزار لوگو

Old password

New Password
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-مثال کاربردی 
PowerEn.ir

انتقال برنامه به لوگو: قدم چهاردهم 

اين امکان برای شما وجود دارد که ابتدا دياگرام مدار خود را تحليل کنيد سپس وسايل مورد نياز را توسط گزينه                       

و يا می توانيد ابتدا توسط                                  وسايلی را که نياز داريد تا مدار خوذ را ببنديد ، .مشخص کنيد
.                       مشخص کنيد

در انتخاب قطعات می توانيد در تمامی انواع لوگو ، مرجع آنها را 

که )تمامی بلوک های تابع و مراجع  در پيکر بندی . مشاهده کنيد 

. ارائه شده است( به نوع ويرايش بستگی دارد

5ويرايش ! نرم افزار لوگو

Tools -> Determine LOGOTools -> Select Hardware
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-مثال کاربردی 
PowerEn.ir

انتقال برنامه به لوگو: قدم چهاردهم 

اگر اتصال بين لوگو و رايانه نتواند به درستی برقرار 

.شود ، پيغامی نمايان می شود

برای اين منظور لوگو را بايد توسط کابل به . بعد از اينکه برنامه شما با موفقيت چک شد بايد آن را به لوگو انتقال دهيد
.رايانه متصل کرد

به مجرد انتقال موفقيت آميزپيغامی  بر روی 

.خط وضعيت مشخص می شود

شما بايد بر روی گزينه         کليک کنيد تا دياگرام 

قبل از انتقال دادن ، . مدار شما به لوگو منتقل شود

ويرايش لوگو برای برنامه مدار پيکر بندی شده بايد 

اگر برنامه مدار پيکر بندی شده نتواند . مشخص شود

بر روی لوگو منتقل شود ، پيغام خطايی نمايان می شود 

.    و انتقال صورت نمی گيرد

5ويرايش ! نرم افزار لوگو
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-مثال کاربردی 
PowerEn.ir

راه اندازی لوگو: قدم پانزدهم 

P

I3

I1

I2

I4

Q1

LOGO! 12/24 RC

LOGO! 

OKESC

Program..

Card..

Setup..

Start

>

s
LOGO! 12/24 RC

LOGO! 

OKESC

Program..

Card..

Setup..

Start>

s
LOGO! 12/24 RC

LOGO! 

OKESC

I :       

0..  123456789

1..0123456789

2..01234

s

سپس برنامه می . بعد از اينکه برنامه را بر روی لوگو انتقال داديد بايد لوگو را بر روی حالت                 قرار گيرد
.تواند اجرا شود

5ويرايش ! نرم افزار لوگو

RUN-mode
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-مثال کاربردی 
PowerEn.ir

تست آنلاين: قدم شانزدهم 

علاوه بر شبيه سازی که می تواند انجام گيرد ، يک تست آنلاين نيز بعد از انتقال برنامه بر روی لوگو می تواند انجام 
.گيرد

1.
2.3.

به منظور فعال شدن تست آنلاين پس از انتقال 

برنامه بر روی لوگو اين گزينه          را انتخاب 

سپس برای قرار گرفتن لوگو در حالت          . کنيد

برای .ران ، از اين گزينه             استفاده کنيد

مشاهده کردن وضعيت آنلاين بايد سمبل عينک        

اکنون شما می توانيد توسط دادن ورودی .فعال شود

.         هايی برنامه خود را شبيه سازی کنيد

5ويرايش ! نرم افزار لوگو
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-مثال کاربردی 
PowerEn.ir

تنظيم ساعت: قدم هفدهم 

.دهيدانجامراکااينوسيلهخودرویازمستقيمبطورتوانيدمیالبته.کنيدتنظيمرالوگوسيستمساعتتوانيدمیشما

ات لوگو و رايانه بايد با کابل به يکديگر متصل شوند تا تنظيم

سپس بر روی گزينه آن .ساعت بر روی لوگو منتقل شود

.کليک کنيد

5ويرايش ! نرم افزار لوگو
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-مثال کاربردی 
PowerEn.ir

تنظيم ساعت: قدم هفدهم 

اين کار را از طريق نرم افزلری و يا از روی . اين قابليت برای شما وجود دارد که با لوگو يک ساعت اتوماتيک بسازيد
.خود وسيله می توانيد انجام دهيد

لوگو و رايانه بايد با کابل به يکديگر متصل شوند تا تنظيمات ساعت 

.اتوماتيک که به کشور انتخابی بستگی دارد بر روی لوگو منتقل شود  .
5ويرايش ! نرم افزار لوگو
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-مثال کاربردی 
PowerEn.ir

تنظيمات متفرقه

.تنظيمات متفرقه ديگر توسط اين گزينه                         می تواند انجام گيرد

5ويرايش ! نرم افزار لوگو

Tools -> Options
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-مثال کاربردی 
PowerEn.ir

مثال های کاربردی

کنترل حامل

-مثال کاربردی 
PowerEn.ir
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-مثال کاربردی 
PowerEn.ir

کنترل حامل

:تعريف تابع 

.يک بطری که حامل را پر ميکند می تواند کنترل شود

قسمت اول

وقتی که کنترل حامل روشن می شود موتور . کنترل حامل توسط سوييچ       خاموش و روشن می شود
.موتور توسط سوييچ      می تواند خاموش شود.حامل فعال می شود

قسمت دوم

سپس موتور به کار . وقتی که سنسور     بطری را مشاهده کرد موتور به مدت سه ثانيه خاموش می شود
. خود ادامه می دهد

I1 (ON)

I3 (OFF)
I2 (filling)

Q1

-مثال کاربردی 
PowerEn.ir

(I1).

(I3)

(I2)
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-مثال کاربردی 
PowerEn.ir

کنترل حامل قسمت اول: راه حل 

:تعريف تابع 

قسمت اول

وقتی که کنترل حامل روشن می شود موتور حامل فعال می . کنترل حامل توسط سوييچ       خاموش و روشن می شود
موتور توسط سوييچ        می تواند خاموش شود .شود

I1 (ON)

I3 (OFF)
I2 (filling)

Q1

-مثال کاربردی 
PowerEn.ir

(I1).

(I3)
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-مثال کاربردی 
PowerEn.ir

کنترل حامل قسمت دوم: راه حل 

I1 (ON)

I3 (OFF)
I2 (filling)

Q1

Edge triggered 
wiping relay

-مثال کاربردی 
PowerEn.ir

(I2)

: تعريف تابع 

قسمت دوم

Part 2 سپس موتور به کار . وقتی که سنسور        بطری را مشاهده کرد موتور به مدت سه ثانيه خاموش می شود

.خود ادامه می دهد

(I2)


